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WELCOME

Welcome to Aladdin’s Spring Cleaning® 5.0, an uninstaller application that helps you recover 
hard disk space by allowing you to remove or better manage your files and applications. Spring 
Cleaning does more than just clean out your drives. The Spring Cleaning application includes the 
following search utilities:

USING THIS GUIDE

Information presented in this guide is optimized for online viewing using hyperlinks to jump to 
important sections in this document. Aladdin hopes this makes using Spring Cleaning easy; your 
feedback is appreciated. To submit your feedback choose iSupport > Feedback & Comments 
from the Spring Cleaning menu bar.

TECHNICAL SUPPORT

Web: http://www.aladdinsys.com/support/techsupport/mac/index.html

This User's Guide should answer the majority of your questions. If you are experiencing crashes 
or freezes while using or attempting to use Spring Cleaning 5.0, please refer to the 
Troubleshooting Read Me which is included in the Spring Cleaning 5.0 application folder's Read 
Us First folder.

Online technical support is available 24 hours a day 7 days a week through the Web site listed 
above. Please be sure to have the following information below handy when requesting support:

• Write down your questions or have a clear idea of the problem.
• Be prepared to duplicate the problem. Write down the steps you took that caused the prob-

lem.

INTRODUCTION

• AccessMonitor • Font Finder

• Alias Fixer • MailCleaner

• Custom Search • Help Finder

• Document Finder • Internet Cache Finder

• Duplicates Finder • MacUninstaller

• Empty Folder Finder • Orphan Adopter

• Fat App Slimmer • Orphaned Pref Finder

• File Checker • Storage Items Finder
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• Be prepared to give the following information:
• Any error messages
• Your computer model
• Your Mac OS version (system version)
• The amount of RAM installed in your machine
• Your Spring Cleaning version number and registration number

HOW TO CONTACT ALADDIN SYSTEMS

Web: http://www.aladdinsys.com
email: service@aladdinsys.com (Not for technical support. For technical 
support, please review the Technical Support section within this Introduction.)
Fax: 831-761-6206
Phone: 831-761-6200
Mail: Aladdin Systems, Inc.

245 Westridge Drive
Watsonville, CA 95076

SYSTEM REQUIREMENTS

Spring Cleaning requires a Power Macintosh computer with 8 MB of free RAM and 13 MB of 
free hard disk space, running Mac OS 8.6 through Mac OS 9.x.x with CarbonLib 1.5 or newer and 
Mac OS X 10.1 or newer.

INSTALLING SPRING CLEANING

If you have an older version of Spring Cleaning on your computer, do not remove it until you have 
installed this version. This will allow Spring Cleaning to retain your preferences from the 
previous version.These instructions work for both Mac OS X and Mac OS 9.2.2 and earlier.

To install Spring Cleaning, do the following: 

1. Double-click the Spring Cleaning® 5.0 Installer icon that corresponds to the 
operating system that you wish to install to. Users on Mac OS X will need to enter their 
administrator name and password in the screen. Click Continue when the installation 
splash screen appears.

2. The installation startup text appears in the next screen. This text includes important infor-
mation. After reading it click Continue. 

3. The Software License Agreement appears in the next screen. Read the agreement and click 
Agree only if you are in agreement and ready to proceed.

4. The registration screen appears next. Enter your name and registration number. Your regis-
tration number appears on the CD package or in an email if you downloaded Spring 
Cleaning. Enter it exactly as it appears. You are not required to enter a company name. 
Please note that if this screen does not appear then you have a pre-registered version of 
- 6 -



                                    
Spring Cleaning and will not have to enter a registration number.

5. Click Register. The installation screen appears next.

6. Click Install. The default directory appears next.

7. Select the location in which to install. If you do not want to install Spring Cleaning into 
the default location, use the buttons to navigate to the folder into which you want to install 
Spring Cleaning.

8. Click Choose. The installer finishes installation.

Note:  The installer may remove components from previous versions of Spring Cleaning or other 
Aladdin products such as StuffIt Deluxe™ and replace them with newer components.

UNINSTALLING SPRING CLEANING

To remove Spring Cleaning from your hard drive, use the following procedure:

1. Follow steps 1-6 of the installation instructions.

2. Choose Uninstall from the pop-up menu.

3. Check the Uninstall Spring Cleaning® 5.0 box.

4. Click Uninstall.

5. Navigate to and select the Spring Cleaning 5.0 folder.

6. Click Choose at the bottom of the dialog.

7. Click Quit.

REGISTRATION

Upon first launch of Spring Cleaning a registration screen will appear. Please take this time to 
register your copy of Spring Cleaning with us. Free technical support is available to all registered 
users. After registering, you will be notified of upgrades, new products, and special offers from 
Aladdin.

Registration is easy. Choose one of four ways:

• Click Register in the Registration screen that pops up after you first launch Spring Clean-
ing.

• Choose iSupport > Software Registration… from the Spring Cleaning menu bar
• Register online at: http://www.aladdinsys.com/register/
• Call Aladdin customer service at (831) 761-6200

Register now, while you are thinking about it.
- 7 -
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ICLEAN OVERVIEW

iClean™ is a quick and easy way to locate and remove files left over from Internet browsing. 
iClean cleans out web cache files, Internet history files, browser cookies, reattaches aliases and 
empties your trash.

If you use a web browser, iClean can recover megabytes of disk space and remove traces of where 
you visited on the web. iClean will also tell you how many megabytes you will save prior to 
removing the files.

USING ICLEAN

The following steps guide you through the general process of using iClean. 

1. Double-click the iClean icon in the Spring Cleaning folder. 

2. Select which searches you want iClean to perform. The first time you launch iClean, all 
searches are selected by default. If there’s one you don’t want performed, click once on the 
icon button for that search. iClean remembers what searches you performed the first time 
and automatically selects those searches for the next launch. You can always change the 
searches you want to perform at any time.

3. Click Clean. If any items are found the Search Results window appears.

4. Examine the Details of each search by clicking Details. In the Details window for each 
search, select or deselect the items you want iClean to remove. When iClean removes files 
they are deleted from your hard disk. There is no Undo for this action. Click Done when 
you finish selecting the files you wish to remove. 

5. Click Finish Cleaning. iClean proceeds to delete the selected items. 

When iClean finishes, a window displays the number of files removed and the amount of space 
saved.

ICLEAN SEARCHES

This section describes the process of each of iClean’s five searches. 

ALIAS FIXER 

Alias Fixer scans for aliases that do not seem to point to a valid location. Aliases can clutter up 
your desktop and slow down navigation. Invalid aliases only make it worse. iClean first attempts 
to automatically reattach these aliases to the original file or application. If there are aliases that 
iClean cannot resolve, they will appear in the Search Results window. In the display for its search 
results there are 2 checkboxes: 

ICLEAN
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Click Fix Aliases Only to reattach aliases with their parent files. This option is on by default. 
When enabled, the Remove aliases... option is inactive. When Fix aliases only is disabled, 
Remove aliases... becomes active and can be checked or unchecked. 

Remove aliases pointing to known disks only is automatically selected for you. Clicking the 
Details button shows only aliases that point to known volumes (such as hard disks or mounted 
servers). All others are not displayed. Choose which of the aliases in that list to remove. 

If both checkboxes are not checked, then all aliases may be removed, whether or not they point to 
known volumes. The Details window displays all of the aliases, and you may choose which to 
keep or remove. Click Details to display all of the invalid aliases found. 
- 9 -



COOKIE TOSSER 

Cookie Tosser locates all the cookies created using the Internet browsers on your Macintosh. This 
includes:

• Netscape Navigator or Communicator
• Microsoft Internet Explorer/America Online
• iCab
- 10 -



Cookie Tosser is more than just a cookie removal method, in fact it is an entire cookie 
management system. Use Cookie Tosser to delete cookies, view cookie details, and hide or 
exclude cookies so that you do not accidentally delete the ones you want to keep. 

The Details window shows all the cookie files from the selected hard drives. When you use this 
feature, your Internet Preferences file is modified, but not deleted.

Microsoft Explorer cookies are stored in a file called Internet Preferences or 
Internet Config for Mac OS X. Netscape 6.X stores them in a file called 
Cookies.txt. Netscape Navigator’s cookies are stored in the file Magic Cookie and iCab 
cookie data is stored in the file iCab cookies. When you click Finish Cleaning, the cookie 
data is removed, leaving the rest of the file intact. These files get deleted or edited when you click 
Finish Cleaning.
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Click on a file you want to edit and click Edit Cookies. The Cookie Editor window is where you 
manage all your cookies. Any changes you make using the Cookie Editor are not saved until you 
click Save. Even if you delete a cookie, you can still recover by clicking Cancel at the bottom of 
the window.
- 12 -



To delete a cookie you no longer want, click on the cookie and click Delete. Delete more than one 
cookie at a time by holding down the SHIFT or COMMAND keys while selecting cookies and 
then click Delete.

There are many different cookies that you might want to keep. For example, the cookies used by 
your bank so you can log into your account and bank online or the cookie for online magazine 
subscriptions and more. To prevent yourself from accidentally deleting these valuable cookies, 
you add them to the excluded list. When cookies are in the excluded list, they are hidden from 
view unless you enable the Include Cookies from Excluded Servers option. You can also add a 
cookie to the Auto-Delete Servers list so that it gets automatically deleted. Clicking the Last Edit 
Session checkbox will show only those cookies that have appeared since the last time you edited 
your cookie list. The display options are color coded so that you can easily see which cookies 
belong to which list if you want all of them to appear. By clicking on a color box you can choose 
which color you would like the text to be displayed in.
- 13 -



To add a cookie to these lists choose a cookie or several by command clicking them and click 
Options.... Click Add Server in the top half of the screen to add the server your chosen cookie 
comes from to a list of servers that will never have cookies displayed in the search results list. 
Clicking the checkbox next to the server name will allow all cookies that come from a server with 
a name that contains the server name specified to also not appear in the cookie list for possible 
deletion.This is helpful for insuring that chosen cookies will not be accidentally deleted. 

Conversely, you can choose to add the server from which your chosen cookie came from, as a 
server to always delete cookies from. Choose a server from either list and click Remove Server to 
remove it from either list. Cancel will cancel all actions taken in this screen. Save will keep all of 
your changes.

Additionally, you can manually add cookies to the either list by typing the server name in the 
Server field and click Add Server. Click Save when done.

To view the cookie data in more detail, click on a cookie in the list and click View Details. The 
details dialog does not let you change any cookie data, but it does show important information 
about a cookie including name, expiration date, value or data itself, whether it is secure and 
whether or not the cookie is enabled.
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WEB CACHE FILES REMOVER 

Web Cache Files Remover locates and removes all the cache files created by any of the Internet 
browsers on your Macintosh. Summary results, including the amount of disk space used by the 
cache files, are displayed in the main window. 

Use the Details window to select or deselect the cache files you want removed.
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INTERNET HISTORY FILES 

Internet History Files Remover locates and removes all the history files created by any of the 
Internet browsers on your Macintosh. Summary results, including the amount of disk space used 
by the history files, are displayed in the main window. 

Use the Details window to select or deselect the history files you want removed.

EMPTY TRASH 

Since you may have accumulated any number of items in your Macintosh trash can, this action 
empties the trash, permanently removing the items in it. Click Details to choose which files are 
actually deleted.
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OVERVIEW OF SPRING CLEANING SEARCHES

Spring Cleaning searches for files you wish to clean or manage on your hard drive or removable 
media. After files are located “actions” can be performed on individual items or groups of items. 
Such actions include deleting files and applications completely, moving them to a StuffIt archive 
or removable disk for archiving purposes, and many other options that help you manage your data 
better. In this User’s Guide, all the actions you can take with a particular search are listed after 
each search description.

Spring Cleaning has support for application packages, long file names, Unicode file names, HFS+ 
file systems and for file sizes greater than 2GB. In Mac OS X applications can be placed in 
packages with all of the necessary components placed in this same pcakage. Under mac OS 9.2.2 
and older these packages apperas as folders.

You can automatically return certain items to their original location using Spring Cleaning’s 
Restore command. See “Restore” on page 30 for more details.

Note that you cannot search for files or folders for which you do not have access rights.

SPRING CLEANING ACCESSIBILITY

You can launch the application by double clicking the Spring cleaning icon or via the Spring 
Cleaning System Menu in Mac OS X. With this handy tool you have access to all of the 
Advanced Mode searches. This menu is available by clicking the broom icon on the upper right 
of your screen. This increased accessibility via the icon will only appear in the Finder Application 
for Mac OS X. You can remove this menu by selecting the menu and command-dragging it off the 
menu bar.

To use the Spring Cleaning System Menu simply highlight a folder or volume and click the 
broom icon. A drop down menu will appear where you can choose a search. Only volumes and 
folders can be writen to will be searched.

SEARCH MODES

Spring Cleaning has two modes of operation, Standard Mode and Advanced Mode. In 
Standard Mode, Spring Cleaning organizes the searches by category: Cleanup, Maintenance, 
Organize, Internet, and Restore.

SPRING CLEANING SEARCHES
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Click on a category on the left to see the available searches. Double-click on a category to expand 
the list of available searches and click on a search to perform then click Continue at the bottom of 
the window. Click Go Back at any time to go back one step.

The following searches are available in Standard Mode:

In Advanced Mode, Spring Cleaning displays its searches in the Search Type window. The 
searches find items based on certain criteria, which you specify, and group them so you can 

• Alias Fixer • Internet Cache Finder

• Document Finder • MacUninstaller

• Duplicates Finder • MailCleaner

• Empty Folder Finder • Orphan Adopter

• File Checker • Orphaned Pref Finder

• Help Finder • Storage Items Finder
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perform a variety of actions. Each search serves a specific purpose and is described in detail later 
in this chapter.

NOTE: AccessMonitor is only available under Mac OS X.

The following searches are available in Advanced Mode:

• AccessMonitor • Font Finder

• Alias Fixer • MailCleaner

• Custom Search • Help Finder

• Document Finder • Internet Cache Finder

• Duplicates Finder • MacUninstaller

• Empty Folder Finder • Orphan Adopter

• Fat App Slimmer • Orphaned Pref Finder
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WHERE TO SEARCH

In Advanced Mode, you select any or all of the drives, volumes, or removable media to which 
you are connected and have permission for your search. Spring Cleaning allows you to select 
exactly where you want to search every time you use the application. A Search Location window 
will appear after you choose a search. In this window you can drag a folder or volume or choose 
one if the volumes listed by clicking and highlighting it. Alternatively you can chose Edit > Add 
Search Context and navigate to the folder, removable media or volume you wish to scan. You 
must choose a folder or volume even if you dragged a folder to the window. You can delete items 
from your list of scannable items by selecting it and pressing the Delete or Backspace key or by 
choosing Edit > Delete. Volumes on local fixed disks cannnot be deleted from this list.

In Standard Mode, Spring Cleaning searches only local volumes. If you want to search CD’s or 
network volumes, switch to Advanced Mode by choosing File > Switch to Advanced Mode.

SEARCH RESULTS

Once a search completes, the Search Results window displays all the files found during the 
search. This window is where you perform “actions” to clean up your hard drive. The actions are 
described in each search utility and in detail in “Actions” on page 40. If you are in Standard 
Mode and want to use an action available only in Advanced Mode simply select “Show 
Advanced Mode Actions” in the Actions pop up menu.

When you select an item in the list, information about it appears in the lower section of the Search 
Results window. You can launch an item from that list by double clicking it.

HOW TO SEARCH

In Standard Mode, the following steps guide you through the general process of finding and 
removing items:

1. Double-click a category to expand the list or click Continue at the bottom of the window.

2. Double-click on the search from the expanded list on the left or you can click on the 
search you want and click Continue. 

3. Choose an action to perform on the items in the results window. You can perform a single 
action on everything or different actions on different files.

4. Click Apply for each action you want to perform. 

5. Click Continue to move to the next search in the same category, or choose a new search 
from the list on the left.

6. Click Conclusion at the bottom of a category to see a summary of searches and actions 
performed in that category.

For Advanced Mode, the following steps guide you through the general process of finding and 
removing items. Some searches have additional steps, which are detailed in their respective 
sections.

• File Checker • Storage Items Finder
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1. Click a search button in the Search Type window. You may only select one search at a 
time.

2. Click Continue. The Search Location window will appear.

3. If you drag a folder(s) to this window or have more than one volume mounted, click the 
item you want to search, or hold Shift or Command keys and click to select multiple items. 
To perform a different search, click Go Back.

4. Click Continue. The Search Results window appears.

5. Choose an action to perform, if desired, on the results using the Action popup menu at the 
top of the Search Results window.

6. You will be prompted to provide additional information for AccessMonitor, Duplicates 
Finder, Document Finder, Custom Search and MacUninstaller. For more information 
about specific requirements, see the section in the online User’s Guide for that particular 
search.

7. To start a new search, click Start Over. If you have more than one drive mounted or need 
to specify new drives to search, click Go Back.

Choosing a search in the Spring Cleaning System Menu will launch Spring Cleaning if it is not 
already launched. Spring Cleaning will automatically open in Advanced Mode. See Advanced 
Mode searching above.

NOTE: For both Standard Mode and Advanced Mode, if there are items in the trash that 
meet the search criteria, they are listed in the Search Results window. We recommend you 
empty the trash before performing a search.

NOTE: AccessMonitor, Document Finder, Duplicates Finder, Custom Search and MacUnin-
staller require additional information to complete the search and you will be prompted for it. 
For more information about specific requirements, see the section below for that particular 
search. Some applications will have files that are not visible to the user but are in fact integral 
files to the application. 

To start a new search, click Start Over. If you have more than one drive mounted or need to 
specify new drives to search, click Go Back.

SEARCHES AND ACTIONS

The next sections of the user’s guide take you through the process of using Spring Cleaning’s 
searches and actions that can be performed. Different searches may have different actions 
associated with them. For a detailed list of all the actions and what they do, see “Actions” on 
page 40.

You have the ability to restore certain items to their original location, using Spring Cleaning’s 
Restore command, accessible in the File menu under Mac OS 9 and earlier, and in the Spring 
Cleaning menu under Mac OS X. If the Restore command is grayed-out, you cannot restore that 
item.

Items may be restored after taking the following actions:
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ACCESSMONITOR 

AccessMonitor is a Mac OS X only search that returns a list of files that have not been accessed in 
a specified length of time. The length of time can be 3, 6, or 12 months or a specific date you set. 
All files matching the search criteria are then presented to you in a window where you can 
perform additional actions on any number of them.

NOTE: AccessMonitor is only available in Advanced Mode.

You can perform the following actions with AccessMonitor:

• Assign Parent
• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Launch with
• Move and Leave Alias
• Move to
• Move to Storage Folder
• Move to StuffIt Archive

• Duplicate to... • Move to Trash...

• Duplicate to StuffIt Archive... • Move to...

• Move and Leave Alias... • Move to StuffIt Archive...

• Move to Storage Folder...
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• Move to Trash
• Replace with Alias to
• QuickCompare
• Run AppleScript

ALIAS FIXER 

Alias Fixer locates aliases that do not point to a valid file on the volume searched. Spring 
Cleaning first attempts to automatically reattach these aliases to the original file or application. If 
there are aliases that Spring Cleaning cannot resolve, they will appear in the Search Results 
window. The aliases that are found are grouped into two categories:

1. “These aliases could not be resolved.”

2. “These aliases point to items not in the search locations.”

Aliases in the first category are most likely truly invalid unless they point to servers or items on 
servers that you are not logged onto while preforming the search. Typically, this is because the 
original item was deleted, but the alias was not. If you do not have the original item, you can move 
these unresolved aliases to the Trash. 

If you recognize aliases that point to items on drives you did not search, you can exclude them 
from future searches since you know they are valid. See “Exclude from Future Searches” on 
page 46.

Aliases in the second category may or may not be invalid. You can also choose to remove them or 
search different locations to find the originals. Use the Point Alias to action in Advanced Mode 
to point the alias to a new item.

NOTE: When running on Mac OS X, the preference setting “Ignore items in Recent… fold-
ers” is not used; these folders will be searched.

You can perform the following actions with Alias Fixer:

• Exclude from Future Searches
• Move to Trash

In addition to the above, you can perform the following actions using Alias Fixer in Advanced 
Mode:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Point Alias to
• QuickCompare
- 8 -



• Run AppleScript

CUSTOM SEARCH

Custom Search is helpful for finding specific items or sets of items to more easily organize your 
Macintosh. This option can be significantly faster since your search is generally more 
targeted.You can move items to a StuffIt Archive, copy to a removable media, or any other of the 
Spring Cleaning actions. You can target your search based on the following criteria

• File name
• Size
• Date created
• Date modified
• Date accessed
• Kind
• Label
• File type
• Creator
• and more!

Choose the volume or folder that you want to search by highlighting the item and clicking 
Continue. The Specify Custom Search Criteria window will appear. This is where you can 
specify what criteria you want to search for. You must specify at least one search criterion to 
proceed. Click OK when you are done.

NOTE: Custom Search is only available in Advanced Mode.
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You can perform the following actions with Custom Search:

• Assign Parent
• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Launch with
• Move and Leave Alias
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash
• Replace with Alias to
• QuickCompare
• Run AppleScript
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DOCUMENT FINDER 

Document Finder is helpful in finding files that were created by an application that is no longer 
installed on your computer. You can find all these files and delete them or archive them. You can 
also use Document Finder to move all files of a particular type into one location for better 
organization. After you click Next in the search type window:

1. Navigate to and select a document of the type you want to find.

2. Click Choose.

Document Finder will find all documents of the same type as the one you selected. The files that 
are found are grouped into four categories:

1. “These files are of the same type and were created by the same application.”

2. “These files are of the same type but were created by a different application.”

3. “These files have the same file name extension.”

4. “These files have a file name extension associated with the selected file type.”
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Files in the first category should have icons the same as the original file you selected. That is 
because they were all created by the same application. 

Files in the second category do not have the same icon. For example, if you select a SimpleText 
text file, then Spring Cleaning will find all files whose type is TEXT. This includes AppleWorks 
files, Microsoft Word text files, and other text files.

The third category has files that match the same file name extension as that of the chosen file but 
do not have the same type and creator.

If the chosen file does not have a file name extension then Spring Cleaning will attempt to match 
the file’s type and creator code and will place those matching files in the fourth category.

You can perform the following actions with Document Finder:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions can be performed with Document Finder in 
Advanced Mode:

• Assign Parent
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• Delete
• Duplicate to
• Launch with
• Move and Leave Alias
• QuickCompare
• Replace with Alias to
• Run AppleScript

DUPLICATES FINDER 

Duplicates Finder locates duplicate and similar files and packages that you may not need. With 
OS X most appliations are palced in packages. These appear as folders in classic. Deleting files or 
packages such as these will help recover wasted disk space. You may choose to not scan for 
duplicate packages in the prompt after you have chosen this search. The items that are found by 
Duplicates Finder are grouped into four categories:

• “Each of these files is similar to at least one other file listed.”
• “Each of these files has an identical name to at least one other file listed.”or if Packages are 

searched for:
• “Each of these Packages is similar to at least one other Package listed.”
• “Each of these Packages has an identical name to at least one other Package listed.”

The items are further grouped into sets, each designated by a disclosure triangle. Click the 
disclosure triangle to hide a particular set. To display the items in the set, click the disclosure 
triangle again.

The first category lists items whose contents are identical. The first item in each set is the first item 
that Spring Cleaning found and is not necessarily the most important one to keep. The indented 
items are duplicates. All copies of a file or package are listed, including the original. 

The second category lists items that have the same name as at least one other item, but the 
contents of the items may not be identical.

It is important to note the differences between the categories. Spring Cleaning searches the actual 
contents of the items on your hard drive to find duplicate files or packages. Thus, in the first 
category, there may be items that have different names that are actually duplicates, while other 
duplicate items listed do have the same name. However, in the second category, items that do have 
the same name do not necessarily have the same contents.

NOTE: Items will only appear in one category. Duplicate items are listed in the first cate-
gory, whether or not they have the same name.

When determining what actions to take on the items returned by this search, the name, size, kind, 
and location of the files are extremely helpful in providing information to assist with your 
decision. 
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If there are only two items of the same name, check their size and kind. This will help you 
determine whether they are the same. If all factors are the same, then the items are most likely 
identical. The surest method for checking duplicate files is to use a file share utility. You can 
double-click a file in the Search Results window to open it for viewing.

In the second category, if there are multiple items with the same name, the size of the files will be 
the most helpful determining factor. For example, there may be four files of the name “Prudence” 
but two are 102k in size and two are 57k in size. This indicates that all four items are not identical. 
Most likely, there are two sets of identical files.

Also note the type of a file. An application and its alias may have the same name, but they are not 
duplicates, and you may want to keep both of them. If there are multiple copies of a preference 
file, keep the one in your active System Folder. Other files associated with a particular application 
are often kept in the folder containing that application. If there are multiple copies of an 
application, you can see the version listed in the Search Results window. It is often best to keep 
only the most recent version of an application. You can use MacUninstaller to remove duplicate 
versions of an application.

You can perform the following actions with Duplicates Finder:

• Exclude from Future Searches
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions can be performed with Duplicates Finder in 
Advanced Mode:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move and Leave Alias
• QuickCompare
• Replace with Alias to
• Run AppleScript

EMPTY FOLDER FINDER 

Empty Folder Finder searches for empty folders. Empty folders don’t take up hard disk space, but 
when you look for files on your computer, empty folders can slow down the find. Many users store 
custom icons on empty folders. By default, the preferences are set to ignore empty folders with 
custom icons.

The folders found in this search are grouped into two categories:

1. “These folders are empty.”
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2. “These folders are empty but have custom icons.”

The second category will only appear if the “Show/hide folders with custom icons”preference is 
enabled. Generally, it is safe to delete any empty folders. Folders titled “untitled folder” or “empty 
folder” can be deleted without hesitation. To remove empty folders, use the Move to Trash action. 

You can perform the following actions with Empty Folder Finder:

• Exclude from Future Searches
• Move to Trash

In addition to the above, you can perform the following actions with Empty Folder Finder in 
Advanced Mode:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move and Leave Alias
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• QuickCompare
• Replace with Alias to
• Run AppleScript

FAT APP SLIMMER 

This search allows the removal of unnecessary application code from your machine, helping to 
regain wasted disk space. Fat App Slimmer is only available as an Advanced Mode search.

Many applications are written for both PowerPC (PPC) and 680x0 processor machines. These are 
called “fat binary” applications. Most programs don’t use both types of code. Spring Cleaning 
looks at your applications and displays a list of those that can be ‘trimmed’ of unnecessary code.

If you do not have a backup of your applications, or you are unsure, set the preferences to create a 
backup copy. See “Trim Fat” on page 65 for more information.
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Once you have trimmed an application, run it to ensure that it is working properly, then empty the 
Trash of the backup copy. If you do need the backup copy, drag it out of the Trash.

The following actions can be taken on the applications found in the Fat App Slimmer in place of 
the Trim Fat action:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Launch with
• Move and Leave Alias
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash
• QuickCompare
• Replace with Alias to
• Run AppleScript
• Trim Fat
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FILE CHECKER 

File Checker searches for damaged files and packages whose structural integrity or data cannot be 
verified. If you no longer need the files, cannot repair them, or have backup copies, then you can 
remove them by placing them in the Trash or you may choose to use a third-party program to 
attempt to fix the files or recover the data. Packages with damaged items will have to be re-
installed.

Spring Cleaning only indicates which files or packages are damaged; it does not fix these items 
for you. Deleting these damaged files can help reduce crashes and freezes.

You can perform the following actions with File Checker:

• Exclude from Future Searches
• Move to StuffIt Archive
• Move to Trash
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In addition to the above, you can perform the following actions with File Checker in Advanced 
Mode.

• Assign Parent
• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move and Leave Alias
• Move to
• Move to Storage Folder
• QuickCompare
• Replace with Alias to
• Run AppleScript

FONT FINDER 

Font Finder is an Advanced Mode only search that searches for fonts wherever they reside on 
your hard drive. A sample of each font can be displayed by single-clicking on the font and 
selecting “Get Info” from the File menu or clicking or hitting Command - I. You can choose to 
take an action on a font from within this “Get Info” window. Depending on what you use your 
computer for, you may have many duplicates of fonts. Deleting duplicate fonts saves disk space, 
lessens RAM requirements, and shortens the start-up time of your computer.

The fonts found are grouped into two categories:

1. “These fonts are in the active System folder.”

2. “These fonts are outside the active System folder.”

In the Search Results window, fonts are grouped into font families. These families are represented 
by a “suitcase” icon. This does not imply, however, that each font has a suitcase; some may not.

Active fonts are those currently in your System folder. These fonts take up memory. If there are 
fonts you do not use, you can move them to an archive or external drive. Fonts that are not in the 
System folder (inactive fonts) do not take up memory. Inactive fonts are generally not available to 
use in most applications. Exceptions include font management utilities.

NOTE: Under Mac OS X, fonts can only be manipulated by the superuser (root). The user 
must be logged in as root (in Mac OS X) to work with Font Finder. Additionally, Font Finder 
only understands “traditional” Mac OS fonts; it does not understand the “.dfont” and “.oft” 
files. See Apple Help for information on becoming the root user.

The following actions are available with Font Finder:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
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• Exclude from Future Searches
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash
• QuickCompare

HELP FINDER 

Help Finder looks for common help files, help engines, help packages, documentation, and “Read 
Me” files that applications install. Once you have used these files, you often do not need them 
again, and they take up hard drive space. You can move them to a removable disk and access them 
only when necessary, or Trash them.

A search engine, or help engine, is an application, control panel, or extension that is used to open 
various help files. A few examples are the Apple Guide extension, the Microsoft Help application, 
and QuickHelp.

The items found are grouped into categories:

1. “These help engines were found.”

2. “These help files were found.”
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3. “These help packages were found.”

4. “These documentation files were found.”

5. “These Read Me files were found.”

6. “These files with “Help” in their names were found.”

You can do several things with the items found by this search. If you move items to a StuffIt 
archive, they won’t take up as much hard drive space and you can access them later if you need to. 
You can move them to an external drive or removable media for access only when necessary. If 
you have read them and feel familiar enough with the program, you can move them to the Trash.

The following actions are available with Help Finder:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions can be performed with Help Finder in Advanced 
Mode:

• Assign Parent
• Delete
• Duplicate to
• Launch with
• Move and Leave Alias
• QuickCompare
• Replace with Alias to
• Run AppleScript

INTERNET CACHE FINDER 

Internet Cache Finder looks for cookie files, history files and cache files created by Web browsers. 
This search can not be run if a web browser is also running. In this case, Spring Cleaning will ask 
you if it can close your browser. 

The items found are grouped into any of nine categories:

1. Netscape Cookie Files

2. Netscape History Files

3. Netscape Cache Files

4. Internet Explorer/America Online History Files

5. Internet Explorer/America Online Cache Files

6. Internet Explorer/America Online Cookie (reside within)
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7. iCab Cookie Files

8. iCab History Files

9. iCab Cache Files

NOTE: Under Mac OS X, Internet Cache Finder is limited to removing Explorer cookies 
from the active Internet Config for Mac OS X file. No path information is dis-
played when the Internet Config file is selected.

NOTE: America Online uses Internet Explorer as their Internet Browser

The following actions can be performed with Internet Cache Finder:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash
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In addition to the above, the following searches are available with Internet Cache Finder in 
Advanced Mode:

• Assign Parent
• Delete
• Duplicate to
• Edit Cookie
• Launch with
• Move and Leave Alias
• Move to
• QuickCompare
• Replace with Alias to
• Run AppleScript

MACUNINSTALLER 

MacUninstaller allows the complete removal of software you no longer need or want. Many 
applications install files all over your hard drive. You may not need all the files that were installed, 
or you may want to remove the application and its associated files from your machine. 
MacUninstaller is designed to seek out all the files associated with an application, including the 
ones you may not be able to recognize or even be aware of, such as invisible files.

You can uninstall any application, package, control panel, or extension. By default, only 
applications appear in the selection list. However, if there is a control panel or extension that is 
associated with an application, it will be listed in the search results window. 

Once you select the storage device, volume or folder(s) and click the Continue button, you can 
choose to browse for a specific application to uninstall or have Spring Cleaning search for all the 
applications on the device. 

Click Browse to navigate to the location of the application you wish to uninstall. 

Clicking Search finds all applications on the selected device. In the dialog box that appears:

1. Scroll down and select the application to uninstall.

2. Click Select.

Spring Cleaning finds all files associated with the application you selected. The items found are 
grouped into a number of categories:

•  “This is the application you selected to uninstall”
•  “These applications may be additional copies or other versions of the item you are unin-

stalling”
•  “These files are associated with the specified application (according to the application)” 
•  “These are files that may be related to other versions of the specified application”
•  “These files are located in the same folder as the application you are uninstalling”
•  “These are documents associated with the item you are uninstalling”
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The categories can help you determine which files to remove. For instance, there may be files in 
the same folder as the application that are not associated with that application. If you have 
different applications in a folder the other applications will be displayed, yet you may not want to 
delete them. Other files are also displayed; if you only want to remove help files, filters, or 
superfluous files for example, you can specify which ones to remove.

If you want to keep the documents that you created with this application, you can exclude them 
from future searches, or you can assign a new parent application to open the files. You can only 
perform one action at a time on a set of files.

NOTE: When run in Mac OS X, MacUninstaller does not detect all files belonging to an 
application on a “Classic Mode” drive. To uninstall applications and files for Mac OS 9 and 
earlier, run Spring Cleaning in “Classic Mode” or reboot into the earlier system.
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The following actions are available with MacUninstaller:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions are available with MacUninstaller in Advanced 
Mode:

• Delete
• Duplicate to
• Launch with
• Move and Leave Alias
• Move to
• QuickCompare
• Replace with Alias to
• Run AppleScript

MAILCLEANER 

Email attachments are the biggest source of extra wasted space for many people. Often, email 
attachments are duplicated by being stored in an email database and separately on your hard drive. 
MailCleaner searches for attachments in Eudora, Microsoft Entourage, and Microsoft Outlook 
Express.
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Click on the appropriate button for your email program from the dialog then click OK. Once the 
search completes, click on an email attachment to find the “path” to the attachment. You can then 
choose whether you want to delete, duplicate, move, or archive the attachment by selecting the 
appropriate option from the Action popup menu.

Microsoft Outlook Express and Microsoft Entourage store all email and attachments in a single 
database file. The file can only be accessed if Outlook Express or Entourage is running. Spring 
Cleaning asks you to launch the program if it is not currently running.
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Again, once the search completes, you can click on an attachment to find out where it resides or to 
perform an action on it.

You can perform the following actions with MailCleaner:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, you can perform the following actions using MailCleaner in Advanced 
Mode:

• Delete
• Duplicate to
• Launch with
• Move and Leave Alias
• Move to
• QuickCompare
• Replace with Alias to
• Run AppleScript
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ORPHAN ADOPTER 

Orphaned files are those that were created with an application that is not on the volumes that were 
searched. If you no longer need these files, you can remove them with Orphan Adopter and its 
related actions, or you can assign a new parent application to the files in order to open them.

In the search results window, first determine which files you no longer need or want and move 
them to the Trash.

Next, look at the type of files that are left. Many word processing programs can open files created 
by other word processing programs. You can assign text files to the word processing program you 
have installed. Many graphics programs can open generic graphic files, such as JPEG, TIFF, or 
GIF files. You can assign graphic files to a graphics program you have installed. Use the Assign 
Parent action to assign these files to a new program so you can access them later.

The following actions are available with Orphan Adopter:

• Assign Parent
• Exclude from Future Searches
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash
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In addition to the above, the following actions are available with Orphan Adopter in Advanced 
Mode:

• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move and Leave Alias
• Move to
• QuickComparee
• Replace with Alias to
• Run AppleScript

ORPHANED PREF FINDER 

Many users often forget that most applications create a preference file in the Preferences folder of 
the Library or System Folder depending on the OS you are running. It is easy to accumulate 
unused preference files, which can add up to a great deal of wasted disk space.

Spring Cleaning helps recover this wasted disk space by finding preference files that don’t belong 
to any application in the specified search location.

However, because of the way preference files are identified by software developers, it is not 
uncommon for preference files to not match up with an application, even if the application is 
present on your hard drive. If you see a preference file for an application that you know you have, 
simply exclude it from future searches.

Preferences for applications can usually be removed without affecting the function of an 
application. However, the preference settings will revert to the default and you will need to reset 
any customized settings you may have changed.
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The following actions are available with Orphan Adopter:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions are available with Orphan Adopter in Advanced 
Mode:

• Assign Parent
• Delete
• Duplicate to
• Launch with
• Move and Leave Alias
• Move to
• QuickCompare
• Replace with Alias to
• Run AppleScript
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STORAGE ITEMS FINDER 

In the Search Results window of any search, you can assign the Move to Storage Folder action to 
an item. This is useful for items that you are not quite ready to throw away and want to save for 
further action later.

Storage Items Finder finds the items you have previously moved to Storage Folders and displays 
them all in the Search Results window. The items are grouped into categories based on the date 
each folder was created and the disk the item is on.

When you choose the Move to Storage Folder action in another search, Spring Cleaning moves 
the selected items to a folder titled with the current date and the name of the search (e.g. 
October 25 - Orphaned Prefs Finder). This folder is created in the “Spring Cleaning 
Storage” folder.

Inside the folder, there is also a document titled What are these folders? This document 
explains what the folder is, how the files inside were moved there, and how to use the files.

The following actions are available with Storage Items Finder:

• Duplicate to StuffIt Archive
• Exclude from Future Searches
• Move to
• Move to Storage Folder
• Move to StuffIt Archive
• Move to Trash

In addition to the above, the following actions are available with Storage Items Finder in 
Advanced Mode:

• Assign Parent
• Delete
• Duplicate to
• Duplicate to StuffIt Archive
• Launch with
• Move and Leave Alias
• QuickCompare
• Replace with Alias to
• Run AppleScript

RESTORE

The Restore feature allows you to undo some of the actions you have taken with Spring Cleaning. 
The Restore feature is accessed via the File menu or by clicking the Restore item in Standard 
Mode.

Items may be restored after taking the following actions:
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The Delete command cannot be restored. 

One log file is generated for each day that you use Spring Cleaning. This file is stored in the 
Spring Cleaning folder. If you use Spring Cleaning in the morning, then quit, come back, and use 
it again at the end of the day, the actions you take during each session will be included in a single 
log for that day.

To open a log file in Standard Mode:

1. Click Restore in the list on the left.

2. Click the Restore button in the pane on the right. A dialog box appears.

3. Select a log file and click Open. The Restore window appears.

To open a log file in Advanced Mode:

1. Choose File > Restore. A dialog box appears.

2. Select a log file and click Open. The Restore window appears.

THE RESTORE WINDOW

The Restore window shows the searches, actions, and items you have worked with on a particular 
day. The date is identified in the name of the log.

• Duplicate to... • Move to Trash...

• Duplicate to StuffIt Archive... • Move to...

• Move and Leave Alias... • Move to StuffIt Archive...

• Move to Storage Folder...
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The Restore window displays a hierarchy of the searches that were run, the actions that were 
taken, and the items that were affected. The status of an item is displayed in the middle section, 
when it is selected. For instance, if an item has not been restored, it will state “This item has not 
been restored.”

When an item is selected, Spring Cleaning attempts to find two things:

1. The original location of the item.

2. The location of the item after the action was applied.

Both locations are displayed in the bottom area of the Restore window. If either the location or the 
item itself cannot be found, that is noted in the status section.

Multiple items can be restored at one time. Once the Restore process is complete, a dialog box 
displays any errors. More information about the errors are displayed in the status area.
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EXCEPTIONS

One of the actions available to you in the Search Results window is Exclude from Future 
Searches. This action prevents an item from appearing in any future searches. You choose 
whether an item is to be excluded from future searches of a particular type or from all searches.

You can also add and remove items from the Exceptions list when not in the Search Results 
window. To view the Exceptions window choose Spring Cleaning > Exceptions in Mac OS X or 
Edit > Exceptions for classic. Use the Add and Delete buttons to make changes to your 
exceptions. Clicking Clear removes all exceptions from the current screen. You can change 
screens by using the Show Exceptions For pop-up menu. The name of each search appears in the 
pop-up menu, as well as All Searches.

ADDING AN ITEM TO THE EXCEPTIONS

1. Select a search from the Show Exceptions For pop-up menu. Any items that are currently 
excluded from that search will be displayed. To exclude an item from all searches select 
All Searches in the pop-up menu.

2. Click Add. A dialog box appears.

3. Navigate to and select an item.

4. Click Choose.

5. Or you may drag items to an open Exceptions window.
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DELETING AN ITEM FROM THE EXCEPTIONS

1. Select a search from the Show Exceptions For pop-up menu. Any items that are currently 
excluded from that search are displayed.

2. Select the item to be removed.

3. Click Delete.

4. Or you may drag items out of an open Exceptions window and into the trash.
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QUICKCOMPARE OVERVIEW

QuickCompare is a separate Mac OS X only program that allows you to quickly and easily 
compare two files, folders or application packages for changes. You can access the application on 
it’s own or through the Spring Cleaning action menu item called QuickCompare. The action item 
is particularly useful with the Duplicates Finder search. QuickCompare graphically shows you 
changes that have been made to each file or folder or just where the two files, folders or packages 
are different.

USING QUICKCOMPARE

To use the QuickCompare application by itself, double-click on the program in the 
Spring Cleaning folder. A window will appear where you can choose the items 
that you want to compare. Once you have chosen your items and clicked the Compare 

button, QuickCompare’s main window will appear. If you are comparing two text files then the 
window that appears will have two parts: a left side and a right side. 

QUICKCOMPARE
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QuickCompare can only display the contents of text files. If you choose a binary file such as an 
application, spreadsheet file, word processor document, and so forth, QuickCompare informs you 
that it cannot display the differences in the files as shown in the dialog below.
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QuickCompare uses color highlighting to determine where two files differ. The colors show extra 
lines in either the right or left file or a line that is changed between the files. While QuickCompare 
is most useful comparing different versions of the same file (two source code files for example), 
you can also compare two completely different files.

QuickCompare will also compare any two folders or packages and their contents. After you 
choose your two folders or packages for comparison a window with three panes appears. The first 
pane on the left shows the items in the first folder that only exist in the first folder. the middle pane 
shows the items in the second folder that only exist in the second folder. The third pane on the 
right shows those items that reside in both folders. 

Items in the third pane can be further compared. Double click on the color highlighted items to 
display their differences. Those items that have a disclosure triangle next to them indicate that 
they are folders.

QuickCompare will only show the differences in the first layer of the folder for that compare 
action. By clicking on the highlighted items in the third pane you can compare the next layer of 
folders. Clicking on all of the disclosure triangles in the first two panes will show the complete 
folder contents where nested items may be different.
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QUICKCOMPARE PREFERENCES

To access QuickCompare’s preferences, choose QuickCompare > Preferences. 

The color preferences are self-explanatory. QuickCompare uses the color preferences to highlight 
changes in either file. To choose a new color, click in the colored area and pick the color you want 
to use.

Ignore Case. Checking this box tells QuickCompare not to consider capitalization as a change 
between the documents.

Ignore Blank Lines. Enable this preference to make QuickCompare ignore blank lines in either 
document.

Ignore White Space. When checked, this preference makes QuickCompare ignore all “white 
space.” White space are extra tabs and spaces in the document. 

Brief Report. Enable Brief Report if you only want QuickCompare to inform you if the two files 
are different as opposed to the specifics of all the differences between the two files. When enabled, 
QuickCompare displays a dialog accordingly as shown below.
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Display Line Numbers. Enable this preference to make QuickCompare display line numbers 
for each text file. This option is very useful when comparing source files (.c or .h for example).

Use Tandem Scrolling. Check Use Tandem Scrolling if you want the scroll bars in the double 
paned window to scroll together.
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QuickCompare 

ACTIONS OVERVIEW

Once Spring Cleaning has completed a search, the items that match the criteria you selected are 
displayed in the Search Results window. You can now perform actions on the items in this 
window. Spring Cleaning offers many options for what to do with the items you have found, 
depending on your needs.

When you perform an action on an item, its appearance in the list changes to italics.

To perform an action:

1. Select the items on which you want to perform the same action.

NOTE: To select more than one item in a row, hold down the Shift key while clicking once 
on each item. To select multiple items that are not adjacent, hold down the Command key 
while clicking once on each item.

2. Choose the action you want to perform from the Action pop-up menu.

3. Click Apply. A dialog box appears. Delete, Move to Trash, Move to Storage Folder, and 
Trim Fat do not display a dialog. These actions happen immediately.

4. Select the appropriate location or file.

Each section below explains what you must select in the dialog box.

NOTE: If you move an item, but later decide you want to move it back, use the Spring 
Cleaning’s Restore feature. Items moved by using the following actions can be restored: 
Duplicate to, Duplicate to StuffIt Archive, Move and Leave Alias, Move to, Move to Storage 
Folder, Move to StuffIt Archive, Move to Trash. For more details, see “Restore” on page 30.

ASSIGN PARENT

This action assigns a new parent application to the selected files. This will be the application that 
is launched when you double-click each file.

After you click the Apply button, before the dialog appears, Spring Cleaning will build a list of 
recommended applications that should to be able to open the selected files. 

When the dialog box appears:

1. Select a parent application to assign to the selected files. Click Choose.

NOTE: You cannot use this action on fonts or folders.

ACTIONS
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DELETE

This action will permanently delete any of the files found in a search. If you do not expect to use a 
file then deleting it can save hard disk space and reduce clutter. Once an item has been deleted, it 
cannot be recovered. If you are unsure whether to delete an item, use the Move to Trash, Move to 
Storage Folder or Move to StuffIt Archive action instead.

The Delete action is not enabled by default. To enable it: 

1. Choose Edit > Preferences or Spring Cleaning > Preferences in Mac OS X. 

2. Select Spring Cleaning.

3. Click Show Delete Action on the right to enable the Delete action. 

NOTE: Since there is no “undo” for a Delete action, give careful consideration before 
changing this setting.

Delete is only available in Advanced Mode.

DUPLICATE TO

Duplicate to is an Advanced Mode only action that duplicates items to a new location while 
leaving the originals untouched. This can be especially useful for backing up project files to 
another server or removable media.

In the dialog box:

1. Navigate to and select the location for the duplicated items.

2. Click Open.

DUPLICATE TO STUFFIT ARCHIVE

This action compresses the selected items into a new StuffIt Archive while leaving the originals 
untouched. It is useful for duplicating and compressing a file or collection of related files to 
another location, server or removable media. Batching the files into compressed archives reduces 
search time, file size and speed of file transmission over networks.

NOTE: This action is similar to Move to StuffIt Archive, with one exception. When you 
duplicate an item to an archive, the original file is left in its original location and a duplicate is 
placed in an archive. You will have two copies of that file. When you move an item, the origi-
nal does not remain. You only have one copy of the file, which is inside the archive.

In the dialog box:

1. Select the location and name of the archive.

2. If you want the archive to be self-extracting, choose Self Extracting Archive (SEA) from 
the pull down menu. Use this option to easily send an archive to users who do not have 
Spring Cleaning or StuffIt Expander. An installer for StuffIt Expander is located on your 
Spring Cleaning CD-ROM, in the Other Aladdin Products folder.
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3. Click Save.

NOTE: You cannot add items to an existing archive.

EDIT COOKIE

Edit Cookie is only available in Advanced Mode even if you use the Internet Cache Finder 
search. Edit Cookie is more than an action, it’s an entire Internet Cookie management system. Use 
Edit Cookie to delete cookies, view cookie details, and hide or exclude cookies so that you do not 
accidentally delete the ones you want to keep. You can even automatically delete cookies based on 
where they came from or if they arrived after a specified date.

The Details window shows all the cookie files from the selected hard drives. When you use this 
feature, your Internet Preferences file is modified, but not deleted.

Microsoft Explorer cookies are stored in a file called Internet Preferences or 
Internet Config for Mac OS X.

NOTE: Under Mac OS X, Internet Cache Finder is limited to removing Explorer cookies 
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from the active Internet Config for Mac OS X file. No path information is dis-
played when the Internet Config file is selected.

NOTE: America Online uses Internet Explorer as their Internet Browser

Click on a file you want to edit and choose Edit Cookies from the Action popup menu and click 
Apply. The Cookie Editor window is where you manage all your cookies. Any changes you make 
using the Cookie Editor are not saved until you click Save. Even if you delete a cookie, you can 
still recover by clicking Cancel at the bottom of the window.

To delete a cookie you no longer want, click on the cookie and click Delete. Delete more than one 
cookie at a time by holding down the SHIFT or COMMAND keys while selecting cookies and 
then click Delete.

To view the cookie data in more detail, click on a cookie in the list and click View Details. The 
details dialog does not let you change any cookie data, but it does show important information 
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about a cookie including name, expiration date, value or data itself, whether it is secure and 
whether or not the cookie is enabled.

There are many different cookies that you might want to keep. For example, the cookies used by 
your bank so you can log into your account and bank online or the cookie for online magazine 
subscriptions and more. To prevent yourself from accidentally deleting these valuable cookies, 
you add them to the excluded list. When cookies are in the excluded list, they are hidden from 
view unless you enable the Include Cookies from Excluded Servers option at the bottom of the 
Cookie Editor window. To add a cookie to the excluded list or to have it automatically deleted 
next time, click on the cookie in the editor window and click Options.
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The selected cookie now appears in the text field for both the “Do not display cookies” and the 
“Automatically delete cookies” lists. Click the first Add Server button to add the cookie to the 
excluded list. Click the second Add Server button to have the cookie automatically deleted when 
ever it appears on your Macintosh the next time you run Spring Cleaning. Additionally, you can 
manually add cookies to these lists by typing the server name in the Server field and click Add 
Server. Click Save when done.

Now, all excluded cookies are hidden unless you click the Exclude Servers checkbox near the top 
of the Cookie Editor window. Excluded cookies are displayed in blue however by clicking on the 
color box you can change the color that cookie appears in. Should a cookie be included in both the 
Exclude Server list and the Auto-Delete list the cookie will not be deleted. 
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Clicking on the Auto-Delete Servers box and Last Edit Session will display those cookies. They 
each have corresponding color codes so that you can easily spot which cookie belongs to which 
list. by clicking on the color box you can change the color that the cookie is displayed in. These 
cookies once displayed will not be reflected in the total count of cookies in the list. The Last Edit 
Session checkbox is checked by default. This is a handy way to quickly note which cookies you 
had in the last session so that you can ignore them or take specific action on them.

EXCLUDE FROM FUTURE SEARCHES

If you have aliases that point to external or removable media, you can exclude them from future 
searches. If you have files whose parent application resides on a server, but you do not want to 
search the server for applications, you can exclude these from future searches.
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This action will prevent the selected items from appearing in the Search Results window. In the 
dialog box:

1. Choose whether the items are to be excluded from future searches of the current type, or 
all search types.

2. Click OK.

At any time, you can add or remove items from the list of exceptions. “Exceptions” on page 33 
covers how to view the items that have been excluded, and how to modify the list.

LAUNCH WITH

Launch with is only available as an Advanced Mode action. Selecting this action opens the 
selected files with a specified application which will provide easier access to files from any 
location. 

In the dialog box:

1. Navigate to and select the application with which to open the files.

2. Click Open.

NOTE: You cannot use this action on fonts.

MOVE AND LEAVE ALIAS

Move and Leave Alias is an Advanced Mode only action that moves the selected items to a new 
location and creates an alias in the current location that points to the new location. Replacing files 
with an alias helps you access and organize files for your own work style.

In the dialog box:

1. Navigate to and select the new location for the items.

2. Click Choose.

NOTE: You cannot use this action on fonts.

MOVE TO

This action moves the selected items from their current location to a new one. Moving files to 
more logical locations can improve productivity and allow you to work faster because file access 
is easier. It is also beneficial for moving items to removable media or servers for backup purposes.

In the dialog box:

1. Navigate to and select the new location for the items.

2. Click Choose.
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MOVE TO STORAGE FOLDER

This action moves the selected items to a folder titled with the current date and the name of the 
search (e.g. October 25 – Orphaned Prefs Finder). This folder is created in the 
Spring Cleaning Storage folder. 

There is also a document in the Storage Folder titled What are these folders? that 
contains information about the folders and the items inside.

MOVE TO STUFFIT ARCHIVE

This action saves hard disk space by compressing all the selected items into one new StuffIt 
Archive and deleting them from their current location. Moving files to remote or portable media 
improves productivity by moving infrequently used files out of the way. Compressing these files 
saves drive space and file transmission time. For details, see “Duplicate to StuffIt Archive” on 
page 41.

MOVE TO TRASH

This action moves an item to the Trash from its current location. This action is an alternative to 
using the Delete action. If you are unsure about deleting an item, use Move to Trash. instead.

If you move an item to the Trash, but decide later that you’d like to move it back to its former 
location, choose File > Restore from the Spring Cleaning menu bar. Alternatively, open the Trash, 
select the item, and choose File > Put Away (Command - Y) in the Mac OS Finder. This will 
move the selected items back to their previous locations.

NOTE: The Put Away command is not available under Mac OS X. Use Spring Cleaning’s 
Restore feature instead.

POINT ALIAS TO

This action directs an alias to point to a new item. In the dialog box:

1. Navigate to and select the item to which the alias should point.

2. Click Choose.

This action is useful if you have aliases that could not be resolved. If an alias is displayed in the 
Search Results window, and you know what it should point to, use this action to point the alias to 
the correct item.

QUICKCOMPARE

QuickCompare is an Advanced Mode only action that passes the selected files to the 
QuickCompare application to perform the actual comparison. QuickCompare can compare text 
files, folders and packages. Only two items can be compared at any time. This action is only 
available under Mac OS X. For more information, see “QuickCompare” on page 35.
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REPLACE WITH ALIAS TO

This action deletes an item and replaces it with an alias of a different item. It can be helpful if you 
have duplicate copies of a file or application. You may not need both copies, yet you access the 
item from both locations. You can replace one copy with an alias to the other, thus saving hard 
disk space.

For example, if you have an application in your Launcher folder and you have the same 
application in your applications folder, you can replace the one in the Launcher folder with an 
alias to the other. Since aliases take up very little disk space, none is wasted by using them.

In the dialog box:

1. Navigate to and select the item for which you would like to create an alias.

2. Click Choose.

NOTE: You cannot use this action on fonts.

RUN APPLESCRIPT

Run AppleScript is only available as an Advanced Mode action. This action will launch the 
selected items in an AppleScript or Frontier droplet. This will run the script you specify using the 
selected items. To open items with different scripts, you will need to perform the action on each 
set of items to be run with a particular script. In the dialog box:

1. Navigate to and select the script with which to open the items.

2. Click Open.

NOTE: You cannot use this action on fonts.

TRIM FAT

This action trims the selected applications of unnecessary code. This action is only available with 
the Fat App Slimmer search. For more details, see “Fat App Slimmer” on page 15.
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SEARCH & VIEW FILTER SETTINGS

These filter settings help narrow down the search results both prior and after the search is 
complete. Use the Search Filter button prior to running a search and the View Settings button to 
further narrow down your results.

SEARCH FILTER

The Search Filter window is similar to the View Settings window with two exceptions. Search 
Filters are applied during your search and the available settings are slightly different than the 
View Settings.

In Mac OS X, the Search Settings window contains items related to creation date, modification 
date, access date, file size, and label.

REFERENCE
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In Mac OS 9 and earlier, the Search Filter window contains four options related to creation date, 
modification date, file size, and file label.

In Standard Mode, Search Filters are applied to every search. In Advanced mode, Search Filters 
are only applied if the Apply Search Filter option is checked in the Advanced Mode window.
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VIEW SETTINGS

Once a search is complete, you can further filter what results are displayed using the View 
Settings button found on the upper left of the search results window. 

The View Settings window displays various criteria you can use to filter the results of searches in 
the Search Results window. The actual View Settings varies slightly depending on the search, but 
the principles are the same. For example, when used with the MailCleaner search, the settings for 
Name and Date can be applied but not the settings for Size and Volume. Also the popup menu 
options say sent before and sent after instead of modified before and modified after. 
Additionally, under Mac OS X these options change to accessed before and accessed after when 
used with the MailCleaner search.
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To set a particular criteria:

1. Click in the box next to the item you want to use as a filter. 

2. Further refine the view using the pop-up menus.

3. If necessary, adjust the date or type one or more words in the search field, or enter a value 
in the file size field. 

4. Click Apply to set and filter the view. 

The filter options you choose take affect immediately. You can change the view settings many 
times to see different results in the Search Results window.
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MENUS

SPRING CLEANING

The Spring Cleaning menu only appears if you are running 
Mac OS X. In addition to the standard choices, this menu 
allows you to Switch to Advanced Mode to access the 
Advanced Mode features of Spring Cleaning. You can 
also set the Preferences and Exceptions as well as Search 
Filter.

FILE 
The File menu contains standard choices. You can also 
choose Restore from this menu when running classic. Use 
the Reveal in Finder menu option to open the parent 
folder of the item and bring the finder forward. If you are 
using Mac OS9.x or older you can choose Switch to 
Advanced Mode to access the Advanced Mode features 
of Spring Cleaning.

EDIT 
The Edit menu allows you to add the Search Context for 
the search you want to run. This where you add a volume. 
remote volume or folder to the volume selection window. 
For older OS’s set the Preferences and Exceptions as well 
as Search Filter in addition to the standard options.
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SELECT 
Using the Select menu, you can select groups of items. Each menu 
item is based on the criteria of the last selected item.

VIEW 
The View menu allows you to sort items in various ways. You can 
view by name (alphabetically), date (chronologically), size (smallest 
to largest), or kind (alphabetically). Each view can be sorted in 
ascending or descending order.

ISUPPORT

The iSupport menu allows you to quickly gain access to 
Aladdin Technical Support, product registration, check 
for updates and to contact us.

HELP

The Help menu allows you to access online help.
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SPRING CLEANING AND ICLEAN SUPER ACCESS

Both Spring Cleaning and iClean have small shell applications that allow you to gain root or super 
access to your Macintosh. Under Mac OS X there are certain files for which you need root access 
permission. Launch Spring Cleaning or iClean Super Access applications any time when you 
know you will be running searches that require you to have permission to access those files. 
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PREFERENCES OVERVIEW

Spring Cleaning’s preference settings are available by choosing Edit > Preferences from the 
menu bar or Spring Cleaning > Preferences under Mac OS X. Spring Cleaning’s preferences 
control how various searches operate. The preference dialog contains a list of preference panels 
for various searches on the left. Click on a preference item from the list to see the settings for that 
search. Not all searches have preferences available for them.

Click Default Settings to change the preferences for all searches to the original settings when the 
program was installed.

The preferences available from this dialog are:

• Spring Cleaning
• Alias Fixer
• Duplicates Finder
• Empty Folder Finder
• File Checker
• Font Finder
• Help Finder
• Internet Cache Finder

SPRING CLEANING PREFERENCES
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• MacUninstaller
• MailCleaner
• Trim Fat

SPRING CLEANING

The preference settings in this panel control Spring Cleaning’s overall behavior. 

SHOW DELETE ACTION 
Show Delete action controls whether the Delete action appears in the Action pop-up menu in the 
Search Results window or not.

IMPORTANT: The Delete action cannot be undone. Deleted items are not recoverable. We 
recommend that you do not enable this preference unless you know what you are doing. If you 
are unsure whether to delete an item, use the Move to Trash action instead.

SHOW GENERIC ICONS

Show generic icons determines what type of icons are displayed. When enabled, Spring Cleaning 
substitutes generic icons for files and applications; resulting in faster searches. If disabled, each 
file displays its own icon.
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ALLOW VERSION CHECKING

This preference is enabled by default and allows Spring Cleaning to check for new updates to 
Spring Cleaning through the internet whenever you start the program. Click Download to retrieve 
a new update when available.

SPRING CLEANING SYSTEM MENU

Checking the Add Finder selection to search locations box will allow items selected in the 
Finder to be placed in the Search Folder/Volumes window. If the Search Finder selection 
automatically box is checked then the items that are selected in the Finder will be automatically 
searched.

ALIAS FIXER

Alias Fixer only has two preferences that control the search behavior.

EXCLUDE ALIASES IN “RECENTLY USED...” FOLDERS 
When enabled, Spring Cleaning will not check aliases located in the Recent Servers, Recent 
Applications, or Recent Documents folders in the Apple Menu.The items in these folders change 
as you use your computer. This preference is enabled by default and we recommend that you leave 
this preference enabled.

RESOLVE ALIASES QUIETLY

When enabled, Spring Cleaning will not ask to mount servers to which aliases point. These aliases 
are listed in the Search Results window in the second category: “These aliases point to items not 
in the search location.” If you disable this preference, you will be asked to mount any servers to 
which aliases on your target drives point including aliases that point to servers as opposed to items 
on the servers. This preference is enabled by default. 

To allow the search to run faster, we recommend that you leave this option enabled.

DUPLICATES FINDER

The Duplicates Finder search has three preference options, Do not show search results warning 
which is disabled by default, Search for duplicate Packages, and Ask whether to search for 
Packages. Packages refer to the way that Apple suggests new applications be presented.
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EMPTY FOLDER FINDER

The Empty Folder Finder search only has one preference option, Ignore folders with custom 
icons and is enabled by default.

Many users store custom icons on folders. This preference allows Spring Cleaning to ignore those 
folders making the found set more manageable and allows you to quickly determine which items 
to remove. Leave this preference enabled if you use empty folders for custom icons.

FILE CHECKER

The File Checker search has only two preference. The Search for damaged packages preference 
allows you to inspect application packages. The Ask whether to search Packages checkbox can 
be unchecked if you do not have any packaged applications or do not want to bothered with this 
alert.
- 60 -



FONT FINDER

The Font Finder search has two preference options that control which font types you search for. 
The preference options are: Find Postscript fonts and Find TrueType fonts.

Both preferences are enabled by default. Spring Cleaning includes PostScript and TrueType fonts 
files in its search.

If you only want to search for one type of font, or you want to exclude specific font types, check 
and uncheck the boxes as necessary.

HELP FINDER

Help Finder can search for more than just “Help” files. Use Help Finder to search for Read Me 
files, text files, PDF files and more. These preferences control what files Help Finder finds. If you 
only want to search for one type of file, or you want to exclude specific types, check and uncheck 
the boxes as necessary.

FIND HELP FILES

Help files are special files installed to provide assistance such as AppleGuide files or HTML help 
files. This preference is enabled by default.

FIND DOCUMENTATION FILES

Documentation files are the “Read Me” or text files installed by software. This preference is 
enabled by default.

FIND HELP ENGINES

A help engine is an application, control panel, or extension that is used to open various help files. 
A few examples are the Apple Guide extension, the Microsoft Help application, and QuickHelp. 
This preference is enabled by default.
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INTERNET CACHE FINDER

The Internet Cache Finder search finds more than just “cache” files. This search also finds history 
and cookie files from the three major web browsers. These preferences control what browser 
application and types of Internet files are returned in the Search Results window. If you only want 
to search for one type of file, or you want to exclude specific types, check and uncheck the boxes 
as necessary.

SEARCH FOR NETSCAPE FILES 
This preference is enabled by default. If you don’t want to search for Netscape files, click the 
checkbox to deselect it.

SEARCH FOR INTERNET EXPLORER/AOL FILES 
This preference is enabled by default. If you don’t want to search for Internet Explorer/America 
Online files, click the checkbox to deselect it.

SEARCH FOR ICAB FILES 
This preference is enabled by default. If you don’t want to search for iCab files, click the 
checkbox to deselect it.

FIND COOKIE FILES 
This preference is enabled by default. If you don’t want to find Cookie files, click the checkbox to 
deselect it.
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FIND HISTORY FILES 
This preference is enabled by default. If you don’t want to find History files, click the checkbox to 
deselect it.

FIND CACHE FILES 
This preference is enabled by default. If you don’t want to find Cache files, click the checkbox to 
deselect it. 

MACUNINSTALLER

The MacUninstaller search tries to find all files related to the application you want to uninstall. 
These preferences control the different kinds of files MacUninstaller finds.

SEARCH FOR RELATED DOCUMENTS 
This preference is disabled by default. Documents created by the application you are choosing to 
uninstall do not appear in the Search Results window. If you may want to access the documents at 
a later time, it is recommended that you leave this preference disabled.

If you enable this preference, all documents created by the application you are choosing to 
uninstall are displayed in the Search Results window.

SEARCH SERVERS FOR PROGRAMS TO UNINSTALL

This preference is disabled by default. If you enable this preference, Spring Cleaning will search 
any mounted servers for applications to uninstall. It is best to leave this preference disabled to 
avoid removing programs that others may use, and to reduce search time.

UNINSTALL CONTROL PANELS 
This preference is disabled by default. If you enable this preference, Spring Cleaning will list 
control panels as items that you can uninstall. If these items are associated with an application, 
they will appear in the Search Results window for an application’s associated files. It is 
recommended that you leave these preferences disabled.

UNINSTALL EXTENSIONS

This preference is disabled by default. If you enable this preference, Spring Cleaning will list 
extensions as items that you can uninstall. If these items are associated with an application, they 
will appear in the Search Results window for an application’s associated files. It is recommended 
that you leave these preferences disabled.
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MAILCLEANER

MailCleaner has many preference options. The the top preferences apply to Microsoft Entourage 
and Outlook Express. The bottom two preferences apply to Qualcomm’s Eudora.

ALWAYS DISABLE SCHEDULES DURING SEARCH

When checked, MailCleaner prevents Entourage or Outlook Express from running any schedules 
to check mail while searching for attachments. This preference is disabled by default.

SCAN CURRENT IDENTITY ONLY

Microsoft Entourage and Outlook Express allow for multiple users called identities. This 
preference, when checked, makes MailCleaner scan only the current identity only. This preference 
is disabled by default.

DO NOT SCAN

The next group of settings control what folders not to search. Messages “in progress” are stored in 
the Drafts folder. You may not want to search for attachments to these email messages as they are 
incomplete for example. 

There are six settings in this group. They are: Folders whose names end with ~, Inbox, Outbox, 
Sent Items folder, Drafts folder, and Deleted Items folder. Check or uncheck the options you 
want as appropriate. All these settings are disabled by default.
- 64 -



SCAN SPOOL FOLDER

Eudora keeps attachments that are being resent or forwarded in the Spool Folder until the 
corresponding message is deleted. This preference tells MailCleaner to search the Spool Folder. 
This setting is enabled by default.

DISPLAY SPOOL FOLDER WARNING ALERT

When enabled, Spring Cleaning displays a warning dialog informing you that it is searching 
Eudora’s Spool Folder. This preference is enabled by default.

TRIM FAT

The Trim Fat search only has one preference option, Make backup copy in Trash.

When enabled, a copy of each application to be trimmed is created in the Trash, prior to the 
trimming process.

This preference is a good ‘backup.’ We always recommend you have a backup copy of an 
application. Once trimming completes and you have verified the functionality of the application, 
you can empty the Trash to recover hard drive space. 

This preference is enabled by default. If you do not have a backup of your applications, we 
recommend that you leave this preference enabled.
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If you move an item to the Trash, but later decide you’d like to move it back to its former location, 
you can. Open the Trash, select the item and choose File > Put Away in the Mac OS Finder (this 
option is not available in Mac OS X). This will move the selected items back to their previous 
locations.

Every file on a Macintosh has two ‘codes’ assigned to it – “type” and “creator.” These codes 
identify the file to the system. The type code determines what type of file it is – an application, 
text file, extension, database file, etc. The creator code is unique for each application and denotes 
the application that created a file.

When you select a file in Document Finder, Spring Cleaning looks at its type code and then 
searches for all files of the same type.

If you always have Adobe Type Manager (ATM) installed and running, you can remove the larger 
bitmap fonts from your System Folder. ATM will generate the larger sizes for you as needed. 
Removing the 18- and 24- point sizes will reclaim large amounts of space.

The following alert may appear: 

“Memory is getting full. The current operation may not be able to continue.” 

If so, try the following procedures:

1. Enable the Show generic icons preference.

2. Close any open applications other than Spring Cleaning, and try the search again.

3. Restart your Macintosh with OS Base settings.

If the problem persists, increase Spring Cleaning’s memory allocation by using the following 
procedure:

1. Quit Spring Cleaning.

2. Open the Spring Cleaning folder.

3. Single-click on the Spring Cleaning application icon.

4. Choose File > Get Info (Command-I).

5. In the Memory Requirements section, increase the Preferred Size by 1000k.

6. Close the Get Info window.

7. Launch Spring Cleaning and try to run the search again.

If the problem persists, repeat steps 2-7 until the search runs successfully.

The following alert may appear: 

“The contents of the disk being searched changed during the search. The results will not 
be complete.” 

This means that while the search was in progress, something on your hard drive caused the 
contents of the drive to change, i.e., another application running. If you run the same search again, 
different results may appear.

SPRING CLEANING NOTES
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You may notice that some of your searches take a bit of time to complete. Searches are much more 
complicated today than in times past.  A number of hurdles have to be cleared in order to provide 
useful results.

One of the key problems is that hard drives are much bigger than they used to be, and contain 
many more items.  Searching over tens of thousands of items to identify matches for a particular 
search can be a huge task. It also takes time to filter out the files that should not be returned as 
results.Spring Cleaning has attempted to bridge this problem by allowing you to search particular 
folders instead of searching over entire hard drives.

Unfortunately, Spring Cleaning has to manually examine every item under consideration as a 
match for a search to determine whether it should be disqualified. This is an expensive operation.  
It is made more expensive by the need to check for the same disqualifying conditions against all 
of the containing folders of each item. This is necessary because while a given item may in itself 
not be invisible or have restricted access privileges, it may be contained by a folder that is 
invisible or has restricted access privileges.

Lastly, the searches supported by Spring Cleaning vary in complexity.  Some searches, like Help 
Finder, may actually consist of dozens of independent searches to find many different kinds of 
items that fits the scope of what the search was intended to find for its users.  This may require 
many passes over the selected search locations, looking for different types of items.

Other searches must physically examine data in files to determine whether the files match the 
searches requirements.  Reading data from disk adds up, especially when it comes to analyzing 
thousands of files.

Spring Cleaning does everything possible to obtain results in the fastest manner it can, in order to 
return the best results to its users, according to their needs.
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